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1. PICmicro Processor and Memory

Each Robot Controller has two built-in PICmicro 18F8520 microcontrollers from Microchip
Technology. One of these PICmicros uses memory that is programmable by the user. This
programmability allows customization of user controls, semi-automatic robot functions, and autonomous
robot functions. This User processor has access to all operator input data and robot sensor data, as well
as control over the PWM and digital outputs used to control motors, relays, and solenoids.

Robot Digital Inputs I
Mgster Pl U_ser | Robot
Operator Input —»|  Micro- »  Micro- Outputs
Controller Controller [

Robot Analog Inputs )

1.2. PICmicro MCU Program Memo

The PICmicro in each Robot Controller has onboard FLASH memory that can be used to store the user’s
custom programs. This memory is non-volatile; meaning that it keeps its memory after power has been
removed. There is a total of 32k bytes of memory space available to the user in which to store custom
programs.

The program in the Robot Controller can be changed by downloading a new program into the PICmicro
memory through the PROGRAM port (more details on page 16).

1.3. Default vs. Custom Programs

The Robot Controller is supplied with a “Default” program loaded into memory in order to help get the
robot up and running quickly. When more sophisticated control of the robot is desired, a custom
program can be quickly created by modifying the Default program. Default “Source Code” for the
default programs are provided at www.InnovationFirst.com. Since Innovation First offers both a smaller
EDU Robot Controller and a full-size Robot Controller, two different sets of code are provided on the
web site. The programs are not interchangeable from one type to the other, but the manner of
programming is the same.
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ge and Windows Software

Programs for the Robot Controller can be written in Assembly or C. For ease of use, the default code
has been written in the C programming language. This high-level language was selected because it is
very powerful and has become an industry standard. Should the user desire, Assembly code can also be
mixed with the C code.

Throughout this document it is assumed that the reader is familiar with the C programming
language and its conventions.

MPLAB IDE is the name of the free Windows program used to edit, compile, and debug PICmicro
programs. MPLAB C18 is the name of the C compiler that must also be installed for use with MPLAB
IDE. Microchip has developed a special version of this C compiler for use with Innovation First Robot
Controllers. This product, called C-BOT, is included in some Robot Controller kits, or it may be
purchased separately from Innovation First.

For downloading custom programs to the Robot Controller, a program named /F1 Loader must be used.
This is included in the C-BOT package, or you can get this program as well as the Default Code for your
Robot Controller as free downloads from www.InnovationFirst.com.

2. PICmicro Software Structure

Inside MPLAB IDE is where the Robot Controller’s program is edited and compiled. From the
“File/Open Workspace...” menu you should open the workspace (.mcw) file downloaded from the
Innovation First web site. You will then see a window listing all the files used in the project (. mcp).
All of these files are necessary, but only a few of them should be edited by the user to create a custom
program. See the next page for details on which files should be edited. To open a file for viewing or
editing, double click on it in the workspace window.

The PICmicro program used in the Innovation First Robot Controllers must adhere to a pre-defined
structure. The structure does not limit the capability of your software; the structure ensures that the
Robot Controller operates properly. This structure is described in the block diagram below.

You can refer to Microchip’s MPLAB C18 C Compiler Libraries manual for more information on
PICmicro commands. That document will not teach you to program in C, but it details libraries specific
to the PICmicro architecture. Not all of the libraries can be used to program the Robot Controller, as
specific functions and registers are reserved for correct operation in the Robot Controller system.

For Assembly language instructions and detailed PICmicro device information, refer to the 18FXX20
datasheet from Microchip.

Note that there is a 64 character path/name limit inherent in the Microchip compiler. That means that
you will get a compilation error if you try to compile a project which has any file whose path and name
length exceeds 64 characters.
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2.1. Commenting Format

Commenting means that the text is for informational purposes to the reader only and is not processed by
the microcontroller. Lines are commented by enclosing the text within the following structure: /x */

Comment Line Examples: The line of code below is completely commented (line starts with /* and ends with
*/ ) and is used for informational purposes. It has no effect on the operation of a program.

/* This text is for informational purposes and is not processed by the compiler. */

Comments can span more than one line:
/* Begin comment

Continue comment

End comment

*/

You cannot nest comment structures. The following is illegal and will not compile:
/* This is /* not allowed */ and won’t work. */

2.2. Declare Variables

All variables used in the programs must be declared by type and name . The 18F8520 has 2kb of data
memory available in which to store variables. Variables may be declared in the . c file where they are
used. There are two primary types of variables that are used in the Robot Controller code. For variables
whose values might range from 0 to 255, the type of unsigned char isused. When values might
range from 0 to 65535, unsigned int isused. All other types within C are also possible, including
double and float (32-bit) types.

The default code defines all the standard input and output variables. The names of the variables used in
the default program can be changed; however, use caution since the name is used throughout the default
code and must be changed at every instance. Declare any additional variables required.

Declare Variables Examples:
/* This is how variables are declared. */
unsigned char loop count;

unsigned int output value; /* Don’t forget the semicolon! */

/* You can declare more than one variable of the same type per line. */
unsigned char loop countl, loop count2, loop count3;

/* You can also initialize the value of variables at the same time you declare them. */

unsigned int countdown = 10;
float pi = 3.1415;

Sharing Variables Between Files Example: If you want to use the same variable (and its value) in more than
one file, this is how you would do it. This is commonly referred to as a global variable.

unsigned int wheel turns = 25; /* Declared in user routines.c, for example. */

extern unsigned int wheel turn; /* Put at the top of user routines fast.c, for example.*/
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2.3. Define Aliases

Aliases provide alternate and sometimes shorter names for variables and sub-divisions of variables.
Aliases don't require any additional memory. The default code uses Aliases to provide logical names for
the Analog Inputs, Digital Inputs, Relay Outputs, Solenoid Outputs, and PWM Outputs. Aliases can
also be used to point to a specific bit within a byte, as in the example below. In the default code, all
aliases have been placed in the alias.h file. You may add your own aliases to this file, but do not
delete any existing ones.

Define Aliases Example: Each line declares one alias. After each variable you can place comments on the use
of the alias in your application. You can see how aliases can save you a lot of typing.

#define countup countdown /* countdown and countup refer to the same variable. */
#define pl sw trig rxdata.oi swA byte.bitselect.bitO /*Joystick Trigger Button */
#define rc dig int0Ol PORTBbits.RB2 /* Refers to a specific input pin of the PICmicro. */
#define rc dig in0l rc dig intOl /* Multiple aliases for the same item are allowed. */

2.4. Define Constants

Constants are fixed values with a name assigned to them. Constants do not require any memory or code
space. Constants provide a convenient means to organize, locate, and edit fixed values in the code.

Define Constants Example: Each line below assigns one constant. The Default Code has several examples of

constants.

#define DATA SIZE 30

#define  SPI TRAILER SIZE 2

#define SPI XFER SIZE DATA SIZE + SPI TRAILER SIZE

#define PWM_NEUTRAL 0x7F /* This is how to write the hexadecimal number 7F. */

2.5. Initialization

Initialization is called from the main. c file. Firsta routine called IFI Initialization() is
called, which sets up crucial system parameters. This call should not be deleted or tampered with.

Next the routine called User Initialization () iscalled. This function resides in the

user routines.c file and may be edited by the user. In this routine the multi-function pins of the
Robot Controller can be set up as either digital inputs or digital outputs (or analog inputs for the EDU
Robot Controller). Follow the examples given in the code to accomplish this.

Not all pins, registers, functions, and peripherals of the 18F8520 User processor are available to the user.
In the initialization section, as throughout your custom code, be careful not to address, use, or otherwise
modify any of them which are already in use elsewhere in the default code. For a list of features which
are off-limits or unusable, please look inthe 1fi picdefs.h file. Ports and registers which should
not be used are marked with the comment: /* Reserved - Do not use */
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2.6. Main Loop call: Process Data From Master uP();

The core function of the default PICmicro program is to call the

Process Data From Master uP () function. This routine performs the following:
1. Read In the Input Data from the operator and on-board robot sensors
2. Perform specific functions based on the Input Data
3. Send Out the results to perform physical movement of the robot’s motors and valves.

v

Getdata <
Data Input

v

Call
Default_Routine
in ifi_default.c

v

Putdata
Data Output

Process Data From Master uP

This loop structure ensures that 1) new inputs (joysticks, etc.) are continuously read in, and 2) the
outputs (motors, Victors, Spikes, etc.) continuously receive new commands. This function is called at a
fixed rate of 26ms for the FRC Robot Controller and 17ms for the EDU Robot Controller.

While this is the maximum rate at which new data is received from the remote operator, it is possible to
execute faster code by placing it outside the fixed timing loop, inside the
Process Data From Local IO ()routineinthe user routines fast.c file.

2.7. Main Loop - Getdata Data Input
The first part of the Main Loop is the Getdata command. This command reads a serial stream of data

from the Master processor. For proper operation of the Robot Controller this command should not be
moved or modified.
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2.8. Main Loop — Default Routine call: Perform Operations Here

After the Getdata function is called and new data is received, the Default Routine () routine is
called. This routine is also located in user routines. c and this is where all the default operation

of the robot is assigned. You can modify this routine to re-map the inputs to outputs, and to perform
special functions.

Perform Operations Example: The main loop below is just an example. Refer to the Default Code for a more
complete example. The code below performs the following functions:

Port 1 Y axis linked to PWM1. PWM2 and PWM3 are set to neutral.

Port 3 Trigger activates Relay 3 in the Forward direction. See the Relay Outputs on page 17.

Port 3 Thumb button activates Relay 3 in the Reverse direction.

Robot digital input 1 automatically activates the roller forward at the speed set by constant ROLLERSPEED.

> W=

/*========= PERFORM OPERATIONS =y

[ Emmmmmmmes Joystick 0 Bl ccocococmoo oo oo e e e e e S S S S S S S om0 wY
= pl_y;
pwm02 = 127; /* Set to neutral. */

= PWM NEUTRAL; /* Another way to set to neutral. Remember our constant? */

[ TEmmmmmme=s Butten te Relay ——c—ssoomsossmemcssssme s e s e e s e e e e e e S e S e e C S S e S e e e =/
relay3 fwd p3_sw_trig; /* Relay 3 Forward Port 3 Trigger */
relay3 rev p3 sw_top; /* Relay 3 Reverse Port 3 Thumb button */

/* relay3 fwd is an Alias to a bit an output pin. */
/* p3_sw_trig is an Alias to a bit in oi swA byte. */

[ Fmmmmmmes= Reller COEle s m oo oo s e e e o e e e e S e e S S e S S S S S S S S o s e S oS =)
if (rc_dig in0l1 == 0) /* Don’t forget to use a double-equals for conditionals! */
{
Roller Out = ROLLER SPEED;
1
else
{
Roller Out = PWM NEUTRAL;
1
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2.9. Main Loop - Putdata Data Output

The final part of the Main Loop is the Putdata command. This command sends a serial stream of data
back to the Master processor. The Master processor then uses this data to drive some of the PWM
outputs. Do not delete, modify, or move the Putdata command line. If it is not executed at least every
26.2ms, the Master processor will disable the User processor and your RC will not function. Therefore
you should not put any infinite loops in your code, or any other code which might take a very long time
to execute.

It is recommended that you set unused PWM outputs to 127, unused relay and digital outputs to 0, and
unused solenoid outputs to 0.

On the FRC, the Master processor will disable all outputs if there is no communication with the
Operator Interface or if the Competition Mode is Disabled, unless you set the Robot Controller to run in
Autonomous mode.

2.10.Main Loop — Return to main.c

The Main Loop is now complete. Program execution will return to the while (1) in the main.c file
and this loop will repeat forever.
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3. Program Inputs

The following sections describe the types of data input to the PICmicro program. The User program
receives some input data from the Master processor inside the Robot Controller. The other inputs come
from local sensors and ports on the Robot Controller which are fed directly to the User processor.

For a FIRST Robotics Control System which uses an RS-422 Radio for communicating with an
Operator Interface, the human operator’s controls are passed into the Robot Controller through the radio
port. The Master processor handles this communication and then sends the control signals to the User
processor.

For an EDU Robot Controller the human operator’s commands are sent using a standard hobby radio-
control (R/C) transmitter and receiver pair. The hobby R/C receiver is interfaced with the Robot
Controller as detailed in the Robot Controller’s user guide. The Master processor takes the signals from
the hobby R/C receiver and digitizes them before sending them to the User processor.

The next two sections will talk about the two types of inputs that are received by the User processor
inside the Robot Controller.
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Digital Inputs are defined as inputs that are either HIGH or LOW. Buttons and switches are the most
common form of digital inputs. In software a digital input is either a zero (0 = LOW) or a one (1 =
HIGH). The Digital Inputs on the Robot Controllers and Operator Interfaces have pull-ups, which
means that they are normally high, or one. That means that if a digital input is open or not connected,
the value read by the PICmicro digital input is HIGH (=1). If a digital input is connected to ground, the
input is LOW (=0). The buttons on the joysticks are an example of digital inputs to the Operator
Interface.

Operator Interface Digital Inputs

Only the FRC Robot Controller can communicate with the Operator Interface. Refer to the Operator
Interface Reference Manual for details on the Digital Inputs. The sixteen (16) Digital Inputs from the
Operator Interface are grouped into two bytes, OI SWA and OI SWB. These input variables are aliased
into more meaningful names such as p1 sw_trig which refers to the trigger of the Joystick connected
to Port 1.

Digital Inputs: The Operator Interface Digital Input aliases are found in the file alias.h of the Default Code.

S Bremple aliages for cach OL gwitch impui ===s=sssssssssoossssssscossossssssoo== %/
#define p4 sw trig rxdata.oi swB byte.bitselect.bit4 /*Joystick Trigger Button*/

#define p4 sw_top rxdata.oil swB byte.bitselect.bit5 /*Joystick Top Button*/

#define p4 sw auxl rxdata.oi swB byte.bitselect.bit6 /*Aux input*/

#define p4 sw_aux2 rxdata.oi swB byte.bitselect.bit7 /*Aux input*/

Robot Controller Digital Inputs

Refer to the appropriate Robot Controller Reference Manual for details on the number and location of
the Digital I/O pins. They are pins which go directly to the User processor. These pins can be
configured as either inputs or outputs in your initialization.

The Default Code already has some of these I/O pins set up as Inputs that you can use with no change to
the initialization code. They have aliases as in the following examples.

Digital Inputs: The Robot Controller Digital Input aliases are found in the file alias.h of the Default Code.

[ e Example aliases for default FRC RC digital inputs —--———————--="""-"""-—————— &Y
#define rc dig inl3 PORTGbits.RG4

#define rc dig inl4 PORTCbits.RCO

#define rc dig inl5 PORTJbits.RJ4

#define rc dig inlé PORTJbits.RJ5

[ e Example aliases for default EDU RC digital inputs —-————-——---"""""""-"—"—-"—-"—-"———-————— )
#define rc dig inl3 PORTHbits.RH4

#define rc dig inl4 PORTHbits.RH5

#define rc dig inl5 PORTHbits.RH6

#define rc dig inlé6 PORTHbits.RH7

NOTE: There are differences between the pin-outs of each type of Robot Controller. This is why the full-size
and EDU Robot Controllers each have a different version of code and they are not interchangeable.
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3.2. Analog Inputs

Analog Inputs are defined as inputs that are can have any voltage value between 0 and 5 volts, not just
ON or OFF. Joysticks, Potentiometers, and Gyro sensors are typically connected to Analog Inputs.
Both the Robot Controller and the Operator Interface (FRC system only) have the capability to measure
analog inputs.

Operator Interface Analog Inputs

Refer to the Operator Interface Reference Manual for details on the Analog Inputs. The sixteen (16)
Analog Inputs from the Operator Interface are each stored in bytes, such as pl x and pl y
corresponding to the X and Y Joystick axis connected to Port 1. The CH FlightStick joystick used with
the Operator Interface has three analog inputs per joystick, the X axis, the Y axis, and the Wheel.

In software, an analog input from the Operator Interface (FRC only) is represented as a number from 0
to 254. The table below shows how an Analog Input varies as the joystick is moved. In the FRC Robot
Controller’s Default Code, the Analog Inputs from the Operator Interface are mapped directly to the
PWM Outputs without modification (see PWM Outputs on page 15). The EDU system uses the
joysticks on standard hobby radio controllers as remote analog inputs. These inputs are similarly
mapped directly to the PWM Outputs on the Robot Controller.

Position and Analog Input Value
Y Axis Full Forward = 254 Neutral = 127 Full Back =0 —25%*
X Axis Full Left = 254 Neutral = 127 Full Right =0 — 25*
Wheel Full Forward = 254 Neutral = 127 Full Back =0 —25%*

* Note: The joystick axes rarely go all the way to zero. This is normal. See the PWM section on page 15.

Analog Inputs: The Operator Interface Analog Input aliases are found in the file alias.h of the Default Code.

[ e Operator Interface (0OI) - Analog InNputs —————————————————————\—\———(—————(————————— )
#define pl y rxdata.oi analog01l
#define p2 y rxdata.oil analog02
#define p3 y rxdata.oi analog03
#define p4d y rxdata.oil analog04
#define pl x rxdata.oi analog05
#define p2 x rxdata.oil analog06
#define p3 x rxdata.oi analog07
#define p4 x rxdata.oil analog08
#define pl wheel rxdata.oi analog09
#define p2 wheel rxdata.oi analoglO
#define p3_wheel rxdata.oi analogll

#define p4 wheel rxdata.oi analogl2
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Radio Control PWM Analog Inputs

Refer to the EDU System Reference Manual for details on interfacing it with standard hobby radio
control (R/C) transmitters and receivers. The joystick movements from the transmitters then become
inputs to the Robot Controller, with their corresponding values stored in bytes.

Analog Inputs: The hobby R/C receiver input aliases are found in the file alias.h of the Default Code.

[ FEemmmmessss Aliases for each radio-control receiver PWM input —-----------——---———————-————— =/
#define PWM inl rxdata.oi analog0l
#define PWM in2 rxdata.oi analog02
#define PWM in3 rxdata.oi analog03
#define PWM in4 rxdata.oi analog04

Robot Controller Analog Inputs

The Robot Controller Analog Inputs have a 10-bit resolution. Refer to the appropriate Robot Controller
Reference Manual for details on the number and location of the Analog Inputs. (Note: The Analog
Inputs of the EDU Robot Controller must be configured in the initialization section, as they can also be
used as Digital 1/O if desired.) The Default Code already has some of these Analog Inputs configured so
that you can use them with no change to the initialization code. The FRC Robot Controller has all 16
analog inputs configured by default. The EDU Robot Controller has only the first four configured.

In order to use them you must call the Get Analog Value function, which resides in the
ifi utilities.c file. This function will return a 10-bit value stored in an unsigned int, or
two bytes. See the example below if you want to assign it to a 8-bit variable, like a PWM output.

Analog Inputs: The Robot Controller Analog Inputs are found in the file alias.h and used as follows.

S Relbet Controller (RC) = Amaleg lmput Aliages ==——===ss=s=sss=s=sscossossssss=o== %/
#define rc_ana in01 ADC_CHO
#define rc ana in02 ADC CHI
#define rc_ana in03 ADC_CH2
#define rc ana in04 ADC CH3

/* Example of using the Analog Inputs to map an analog input to a PWM output. */

unsigned int sensorl;
unsigned char sensorl 8bits;

sensorl = Get Analog Value( rc ana in01l ); /* Assign the analog reading to a variable. */
sensorl 8bits = (unsigned char) (sensorl >> 2); /* Only take the 8 most significant bits, */
pwmOl = sensorl 8bits; /* because PWM OUTPUTS can only be 8 bits. */

/* Or you can do it all in one line like this. */
pwmOl = (unsigned char) (Get Analog Value (rc ana inOl) >> 2);
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4. Program Outputs

The following sections describe the types of data and actions that are output from the PICmicro
program. Most of the output pins of the Robot Controller are directly tied to the User processor and can
be addressed by the user in their code.

4.1. PWM Outputs

The PWM Output Ports on the Robot Controllers are all controlled by PICmicro software. Each PWM
output provides variable speed control for a motor in both Forward and Reverse.

PWM stands for Pulse Width Modulation and is the type of signal commonly used to control Speed
Controllers such as the Victor 884. This PWM signal is the standard hobby R/C type used on model
airplane controls. This PWM is not the regular duty-cycle type output by most microcontrollers.

PWM Outputs: The PWM outputs have aliases defined in the alias.h file. By assigning a value from 0 —
254 to them you can control the speed of a motor.

[ ————————— Example Aliases for Robot Controller PWM outputs -——————-———"————"—"—————————————— i/
#define pwmO1l txdata.rc pwmO1l
#define pwm02 txdata.rc pwm02
#define pwmO3 txdata.rc pwm03
#define pwmO4 txdata.rc pwmO4

In the EDU system any given PWM output signal can be created by either the Master or the User
processors. See the Setup Who Controls Pwms functioninthe User Initialization
routine of the user routines. c file in the EDU Default Code to do this. In the Default Code the
Master processor controls all PWMs according to the values stored in pwmOx variables and sent in the
PutData () function. This means that PWM outputs can only be changed every 17ms when the
Master gets the new values from the User processor. If the User processor is set up to control one or
more PWM outputs, it can change those outputs every program loop if desired by using the
Generate Pwms function.

EDU Robot Controller PWM Outputs: Here are some example lines of code to show how the PWMs are
controlled.

/* Setup Master processor to control PWMs 1-4, User to control PWMs 5-8. */
Setup Who Controls Pwms (MASTER,MASTER,MASTER,MASTER, USER,USER,USER,USER) ;

pwmOl = pwm02 = pwm03 = pwm04 = pwm05 = pwm06 = pwm07 = pwm08 = 42;

/* Every 17ms Master will generate PWMs 1-4 according to values stored in pwmOx variables. */
Putdata (&txdata) ;

/* The User processor will generate PWMs 5-8 with whatever values are passed as arguments to

this function. Notice that the values for PWMs 1-4 will be ignored, since the Master

controls them. Also notice that PWM 8 will be set at neutral. It must be type-cast. */
Generate Pwms (1,7%,ZERO, ZERO, pwm05, pwm06, pwm07, (unsigned char)127;
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In the FRC system the values for PWM signals 1-16 are all sent to the Master processor from the User
processor using the PutData () function. The Master processor, however, only generates the signals
for PWMs 1-12. The signals for PWMs 13-16, however, are generated directly by the User processor by
using the Generate Pwms function. As with the EDU RC, this means that PWMs 1-12 can only be
changed every 17ms, while 13-16 can be changed as often as the program loop executes. You must use
both the Putdata (&txdata) and the Generate Pwms (pwml3,pwml4, pwnl5, pwnl6)
commands to generate all 16 PWM output signals.

The most common method of controlling a PWM output is via the joystick Analog Input. By sending a
joystick Analog Input to a PWM output, a motor connected to the PWM port will act as follows:

Action (FRC system) Function and Analog Value

PWM Speed Controller Full Forward = 254-227 | Neutral = 136-123 Full Reverse = 0 — 37
Joystick Y Axis Full Forward = 254 Neutral = 127 Full Back =0 —25
Joystick X Axis Full Left = 254 Neutral = 127 Full Right =0 -25
Joystick Wheel Full Forward = 254 Neutral = 127 Full Back =0 —25

Refer to the appropriate Robot Controller Reference Manual for details on the number and location of
the PWM Outputs.

Example (using the default FRC software): Move the Y-axis on the Port 1 Joystick forward to make a
motor connected to PWMI1 turn. The further you push the joystick, the faster the motor turns. From a
neutral position move the Y-axis on the Port 1 Joystick backwards to make a motor connected to PWM1
turn the other direction. Again, the further you push the joystick, the faster the motor turns.

FRC Robot Controller PWM Outputs: The FRC default code maps the joystick Analog Inputs from the
Operator Interface to the PWM outputs as follows. Elsewhere in the code, the Generate Pwms() and Putdata()
functions are called to generate the PWM output signals.

[ FEemmmmessss Analog Inputs (Joysticks) to PWM Outputs-------------——--——-——-
K e e e e e o o o o o o o o e e o o e e e e e e e o e o e e e e
& This maps the joystick axes to specific PWM outputs.

*/

pwm0l = pl y;
pwm02 = p2 y;
pwm03 = p3 y;
pwm04 = p4 y;
pwm05 = pl x;
pwm06 = p2 x;
pwmO7 = p3 x;
pwm08 = p4 x;
pwm0S9 = pl wheel;
pwmlO = p2 wheel;
pwmll = p3 wheel;
pwml2 = p4 wheel;

Generate Pwms (pwml3,pwml4, pwml5, pwml6) ;
Putdata (&txdata); /* Send my data to the master microprocessor. */
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4.2. Standard Digital Outputs

Refer to the appropriate Robot Controller Reference Manual for details on the number and location of
the Digital I/O pins. They are pins which go directly to the User processor. These pins can be
configured as either inputs or outputs in your initialization.

The Default Code already has some of these I/O pins set up as Outputs that you can use with no change
to the initialization code. They have aliases as in the following examples.

Digital Outputs: The Robot Controller Digital Output aliases are found in the file alias.h of the Default Code.

[Fmmmmmm=== Example aliases for default FRC RC digital outputs —-————-——---"""-"""--————— &Y
#define rc dig outl3 LATGbits.LATG4

#define rc dig outl4 LATCbits.LATCO

#define rc dig outl5 LATJbits.LATJ4

#define rc dig outlé LATJbits.LATJ5

[Fmmmmmm=== Example aliases for default EDU RC digital outputs ———-——---—""-"-"—"—"-"—"—"—-"————————— &Y
#define rc dig outl3 LATHbits.LATH4

#define rc dig outl4 LATHbits.LATHS5

#define rc dig outl5 LATHbits.LATH6

#define rc dig outlé LATHbits.LATH7

[ ————————— Example usage of digital oUEpUtsS —=———=—————————————————— i/

if (pwmOl > 227) /* If pwmOl is greater than 227... */

{
rc _dig outl
rc_dig out2
}

1g /* then output a HIGH on digital output port 1 */
rc dig in3; /* and map digital input 3 to digital output 2. */

NOTE: There are differences between the pin-outs of each type of Robot Controller. This is why the full-size
and EDU Robot Controllers each have a different version of code and they are not interchangeable.

4.3. Relay Outputs (FRC onl

The Relay ports on the FRC Robot Controller are all controlled by PICmicro software. The Relay
outputs provide Full Forward, Full Reverse, and OFF control for motors and other devices when
connected with a Spike Relay. Each relay port has 2 digital outputs. Refer to the appropriate Robot
Controller Reference Manual for details on the number and location of the Relay Outputs.

Example (using the default software): Press the Trigger button on the Port 1 Joystick to put a Spike
Relay connected to RLY'1 in the Forward position. This would cause a motor connected to this relay to
turn at its maximum speed. Press the Top button on the Port 1 Joystick to put the Spike in Reverse
position, thereby reversing the motor. The relays in the example below are limited by limit switches
connected to Digital Inputs 1 and 2.

Relay Digital Outputs: The relay outputs have aliases defined in the alias.h file. Here is an example of how
to use them.

S Exemple Alilages for Rebot Controller relay CQUERPULY =====—s=s==s=sscssssssssss=o== %/
#define relayl fwd LATDbits.LATDO
#define relayl rev LATEbits.LATEOQ
#define relay2 fwd LATDbits.LATD1
#define relay2 rev LATEbits.LATEL
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[ TEmmmmmme=s Byemple usege Of relay POLLs ————sssmmmmcsssssssssssssossssse s e s e e e e e =/
/* When the switch on rc dig in0l is closed, the value will be 0. */
/* This will make relayl fwd also be 0, no matter what the value of pl sw trig is. */

relayl fwd = pl sw trig & rc_dig in0O1;
relayl rev = pl sw top & rc dig in02;

4.4. Solenoid Digital Outputs (EDU onl

The solenoid outputs on the EDU Robot Controller are essentially treated as digital outputs in the
software. A high, or 1, will energize (turn on) the solenoids, and a low, or 0, will shut them off.

Example (using the default software): Push the joystick corresponding to R/C PWM IN 3 forward past
the programmed threshold of 160 to energize solenoid 1. Pull it backwards past 95 to energize solenoid
2. In the neutral position both solenoids will be off.

Solenoid Digital Outputs: The solenoid outputs have aliases defined in the alias.h file. Here is an example
of how to use them.

[ TEmmmmmme=s Example Aliases for EDU Robot Controller solenoid outputs --------------——--——— =/
#define solenoidl LATDbits.LATDO
#define solenoid?2 LATDbits.LATD1
#define solenoid3 LATDbits.LATD2
#define solenoid4 LATDbits.LATD3
#define solenoid5b LATDbits.LATD4
#define solenoid6 LATDbits.LATDS
A R/C PWM INPUTs toggle solenoids ————————————————————————————— =
if (PWM in3 < 95) /* PWM _in3 forward (typically) */
{
solenoidl = 1; /* turns on Solenoid 1 */
solenoid2 = 0; /* turns off Solenoid 2 */
}
else if (PWM in3 > 160) /* PWM in3 reverse (typically) */
{
solenoidl = 0; /* turns off Solenoid 1 */
solenoid2 = 1; /* turns on Solenoid 2 */
}
else /* PWM in3 neutral band */
{
solenoidl = 0; /* turns off Solenoid 1 */

solenoid2 = 0; /* turns off Solenoid 2 */
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5. Downloading User Code to the Robot Controller

The Robot Controller downloading steps are as follows:

1. Compile a valid program in MPLAB IDE by selecting “Make” from the “Project” menu. This
will generate a . hex file with the same name as the project name. You may also use the
xxx_Default.hex file which has been pre-compiled to restore the default functionality.

2. Power ON the Robot Controller.

3. Connect a DB9 Male-to-Female Pin-to-Pin cable (maximum length 6 ft.) from the PROGRAM
port on the Robot Controller to PC’s serial port.

4. Run the /FI Loader application from Start -> Programs -> IFI_Loader -> IFI_Loader.

5. Right click and select the appropriate COM port in the lower right corner of the IFI Loader
window.

6. Click the “Browse” button and select the desired . hex file which you compiled from within
MPLAB IDE.

7. (EDU RC only) Briefly press the “PROG” button on the Robot until the Program State LED
becomes solid orange. Now it is in Program Download mode. (On some PCs, this step must
also be performed for the FRC Robot Controller by pressing the “Download” button.)

8. Click the “DOWNLOAD?” button in /FI Loader. The Program State LED will blink orange.

9. When the download is complete the Robot Controller will automatically reset. There is no need
to power cycle it. If the program is good, the Program State LED will blink green. A terminal
window will automatically open within /F1 Loader where any text output from the Robot
Controller will be displayed.

Note: Before the new User program will start executing, an FRC Robot Controller must have a Valid
RX (link) to an OI or the RC must be in Autonomous Mode.

5.2. PROGRAM STATE LED

Depending on the status of the User processor, the PROGRAM STATE LED will be green, orange, or
red, and blink or stay on solid.

After programming the Robot Controller you should see the PROGRAM STATE LED flashing green.
This LED indicates that the new program is running. For the FRC system you must also be linked to an
Operator Interface or else this LED will be solid green and the program will not be running.

The PROGRAM STATE LED will be a solid orange if it is waiting for new user code to be downloaded.
This will occur if the PROG button is briefly pressed on the Robot Controller. Pressing this button is
only necessary for the EDU Robot Controller. It may also be necessary for the FRC Robot Controller
on some PCs. If you are unable to download to the FRC Robot Controller, you may need to press the
PROGRAM button to change the LED to orange.

While a new program is being downloaded, the PROGRAM STATE LED will blink orange.
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The PROGRAM STATE LED will be red if the Master processor is unable to communicate with the
User processor. This can occur if something in the User Code interferes with the inter-processor
communication by writing to a reserved area.

6. Additional Programming Techniques

If you leave the serial cable connected to your Robot Controller after programming it, the following
routines can be used to print data to your computer screen. You can display the data in any serial
communications terminal application. /FI Loader has a Terminal Window which can be used for this
purpose, or you may use the application HyperTerminal. HyperTerminal is located in Start->Programs-
>Accessories->Communications. Settings for HyperTerminal are: Bits per second: 115200, Data bits: 8,
Parity: None, Stop bits: 1, Flow control: None. You might also want to check “Append line feeds to
incoming line ends” in “File->Properties->Settings->ASCII Setup...”.

These commands provide a convenient way for your PICmicro program to send data to the PC screen
while running. Some possible uses include debugging programs by showing you the value of a variable
or expression, or by indicating what portion of a program is currently executing. Once your program
has been debugged, however, you should remove all such serial text output commands so that your code
will run as fast as possible in your robot.

6.1. The printf() Command

The most common method to print text output to a screen in C is the printf() command. While this
command is not included in the Microchip C library, IFI has implemented a limited model of printf in
the printf 1ib.c file. Please examine this file to learn the limitations of the IFI implementation as
well as to see examples of how to create your own custom output modules. The default code has the
following example included to get you started.

printf () Example: The following example demonstrates the use of a printf() command to display the decimal
values of PWM OUT 7 and 9 to the computer screen.

printf ("PWM07 = %d, PWM08 = %d\n", (int)pwmO07, (int)pwm08); /* printf example */

Notice that the values displayed (pwmO07 and pwm08) are of type unsigned char and must be typecast as int to
work with this command.

6.2. Other Serial Debug Statements

While the printf() function is a standard C library, its use requires more processing power than the
following utilities. The commands which follow are faster methods of printing data to a PC terminal
screen, although they do not allow the flexibility and formatting of a printf statement. These commands
are contained in the file 1fi utilities.h and can be useful for debugging your programs when
execution speed is important.

You may also create your own custom serial output functions using these as models.
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PrintByte Example: The following example demonstrates using the PrintByte command to print bytes of
data in hexadecimal format to the computer screen.

A Somewhere in the Main LOOp ———=———————————————————\—"—\—"——~——\—~—~\—~—~\—(—~—\—(—~\————————— wf
PrintByte (0xC4) ; /* Print a hard-coded value. */
PrintByte (pwm01) ; /* Print a variable value. */

After you add these lines somewhere in the main loop, and after downloading, the /FI Loader will open a
Terminal Window on your PC screen and wait for data from the Robot Controller. You should see “C4” and “7F”
repeating, each on their own lines. “7F” should vary depending on the value of pwm0O1, an output variable.

These lines will repeat every loop of the code. Note that if you close the Terminal Window, your program keeps
executing, but you can't see the debug data anymore. You can reopen Terminal Window from the Options menu.
Optionally, you can use HyperTerminal to view the data.

PrintWord Example: This function will print a word of data, or two bytes, in hexadecimal format.

[Femmmmemm== Somewhere in the Main LoOp —————————=———————————————\——————~\—\—\—\————————————— 7/
PrintWord (0xC4Al) ; /* Print a hard-coded value. */

You should see “C4A1” printed on your screen. A carriage return is automatically added.

PrintString Example: You can also print text strings using this function.

A Somewhere in the Main LOOp ———=——=—————————————————\——\—"—~—\—~—\—(—~\—(—~———— =y
PrintString( (unsigned char *) "ERRORI\r" ); /* Print a text string. */

This example will display “ERROR1”. The “\r” performs a carriage return. To use this function, simply replace
“ERROR1” with the text you would like to print.

DisplayBufr Example: This function will display all 26 bytes of either the TXDATA or the RXDATA
buffer. In this manner you can snoop on the data being sent to or received from the Master processor. It is a good
candidate for customization so that you can display your own long buffers.

[ Fmmmmmmes= Someyhecrs in the Maln LEEp =—==—=———mcss—ssssc—ssooossosssooosoosos s s e */
DisplayBufr ( &rxdata ); /* Print the 26 bytes received from the Master processor. */
DisplayBufr ( &txdata ); /* Print the 26 bytes sent to the Master processor. */

This example will dump all 26 received bytes on one line before inserting a carriage return and then printing the
26 transmitted bytes with another carriage return. See what happens if you use this and move the joysticks on
your control system!

6.3. Robot Feedback and User Mode (FRC onl

The FRC Robot Controller has the ability to send data back to the Operator Interface. The Robot
Controller can send 11 bits every loop of the code. The data is available on the Operator Interface in
three ways: 1) On the 11 Robot Feedback LEDs, 2) on the multi-segment display when in user mode,
and 3) on a PC connected to the Dashboard Port. See the PB_Mode section (page 23) for writing code
that can display numbers on the multi-segment display.
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The Robot Feedback bits are passed from the User processor to the Master processor in the txdata
packet. The Master processor then sends the data to the Operator interface via the Radio Modems. You
can change the Feedback bits one at a time as in the example below.

Robot Feedback Example: The Default Code assigns aliases to the bits which control the Robot Feedback LEDs
on the Operator Interface. These aliases are defined in the alias.h file. The user can change these aliases.

[Femmmmemmm== Example aliases for the ROBOT FEEDBACK LEDS ———=—=—=——————=—=—————————————————————— =y
#define pwml green txdata.LED bytel.bitselect.bitO
#define pwml red txdata.LED bytel.bitselect.bitl
#define pwm2 green txdata.LED bytel.bitselect.bit2
#define pwm2_ red txdata.LED bytel.bitselect.bit3

The values of these LEDs (ON or OFF) are set in the Default Code in the ifi_default.c file. Here is an excerpt.

if (pl y >= 0 && pl_y <= 56)

{ /*Joystick is in full reverse position*/
pwml green = 0; /*Turn PWM1l green LED - OFF */
pwml red = 1; /*Turn PWMl red LED - ON #y

}
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6.4. RC Mode — Competition, Autonomous, and User (FRC RC onl

The rc_mode byte is a byte accessible through the GetData command. The Competition Mode,
Autonomous Mode, and User Mode are all available in this byte. The Default Code already contains all
the code needed to use these modes.

Competition Mode

Bit 7 of rc_ mode byte (aliased as competition mode below) indicates the status of the
Competition Control, either Enabled or Disabled. This indicates the starting and stopping of rounds at
the competitions. Competition Mode is indicated by a solid "Disabled" LED on the Operator Interface.
When Disabled, all program execution is stopped.

competition mode = 1 for Enabled, 0 for Disabled.

Autonomous Mode

Bit 6 of rc_mode byte (aliased as autonomous_mode below) indicates the status of the
Autonomous Mode, either Autonomous or Normal. This indicates when the robot must run on its own
programming. When in Autonomous Mode, all OI analog inputs are set to 127 and all OI switch inputs
are set to 0 (zero). Autonomous Mode is indicated by a blinking "Disabled" LED on the Operator
Interface.

autonomous mode = 1 for Autonomous, 0 for Normal.

Autonomous Mode can also be turned ON by setting the RC to Team 0 (zero) and power cycling the RC
unit. Note that if competition mode = 0 (Disabled), then Autonomous Mode is also disabled.

User Mode

Bit 5 of rc mode byte (aliased asuser display mode below) indicates when the user selects
the "User Mode" on the OI. PB_mode.bit5 is set to 1 in "User Mode". When the user selects channel,
team number, or voltage, user display mode is set to 0. When in "User Mode", Robot Feedback
LEDs are turned off and the value stored in txdata.LED bytel.data is displayed on the multi-
segment display on the Operator Interface. In the default code this is set to the value of Port 1 Y-Axis.

Note: "User Mode" is identified by the letter “u” in the left digit (for 4 digit OI's)
Note: "User Mode" is identified by decimal places on the right two digits (for 3 digit OI's)

Autonomous _Mode Example: This example shows portions of the code that reference rc mode byte. The
Perform Operations Section below uses aliases based on rc_mode byte bits to execute different sections of
code.

The following three aliases are declared at the end of the alias.h file:
#define user display mode rxdata.rc mode byte.mode.user display
#define autonomous_mode rxdata.rc mode byte.mode.autonomous
#define competition mode rxdata.rc mode byte.mode.disabled

For code you wish to have run in Autonomous mode, you must edit the User Autonomous Code () routine

in the user routines fast.c file. Here is an excerpt from main.c which calls the autonomous code:
if (autonomous mode) /* DO NOT CHANGE! =*/
{

User Autonomous Code () ; /* You edit this in user routines fast.c */

}
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User Mode Example: This example shows the Default Code that changes the data sent to the Operator Interface
when the user sets the Operator Interface to User Mode.

if (user display mode == 0) /*User Mode is Off */
{

/* This section of code deleted for this example. */
} /* (user display mode = 0) (User Mode is Off) */

else /* User Mode is On */
{

txdata.LED bytel.data = pl y; /* Change pl y to a value in which you are interested. */
}

7. PICmicro Commands

Not all features of the 18F8520 PICmicro can be used by the user who is writing custom code for the
Innovation First Control System. Certain registers are reserved because they are used to allow the User
processor to function within the embedded system. Modification of these registers may result in
improper operation or in the Robot Controller failing to function at all.

Refer to the file ifi picdefs.h to find out which registers and bits are reserved by the system, or
are not available to the user. It is not necessarily comprehensive, since many registers have multiple
functions, some of which may be allowed, while others are not. For a complete pin list of the usable
pins which you can access in your custom code, please refer to the appropriate Robot Controller user
guide.

If your Robot Controller ceases functioning after a program change, you should revert back to the last
known working version and then incrementally add back in the new code until you find what caused the
problems. It is good programming practice to keep an archive of old code so that you can do this.



